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APPLI CATI ON OVERVI EW

W ELCOME SCREEN 

To display the W elcom e Screen 

1. Launch Adobe Acrobat  X from the Start  Menu or a desktop shortcut , without  

select ing a specific f ile to open. 

2. The Welcome Screen cannot  be disabled and will always display when no act ive 

file is open. 

To open a Recent  File using the W elcom e Screen 

1. Click on the file name in the Recent  File list  on the Welcome Screen. 

2. I f the file name is not  displayed on the Recent  File list , click on  

and browse to the desired locat ion. 

To perform  a task using the W elcom e Screen 

1. Select  a shortcut  from  the Get t ing Started  pane. 

2. The following workflows are available from this pane:  

Create PDF 

Create PDF Port folio 

Com bine Files into PDF 

Create PDF Form  or Online Form  

Share Files Using SendNow  Online  

 

MENUS 

 

The number of menus and submenus has been dramat ically reduced from pr ior  

versions of Acrobat . 

To use the tools on the File  m enu 

1. Click the File menu (Alt  +  F) . 

2. The following opt ions are available:  

Open  – browses to a PDF file to open;  or browses to a non-PDF file and 

converts and opens. 

Create  – creates a PDF from an exist ing elect ronic file, from  an at tached 

scanner, from a web page, or from the Clipboard contents;  combines mult iple 

files into a single PDF;  runs a batch process to create mult iple PDF files;  creates 

a PDF form or on- line form ;  or creates a PDF Port folio. 

Save  – saves changes to the act ive file. 

Save As – saves the act ive file with a new name;  create a Reduced Size PDF;  

create a Cert if ied PDF;  create a Reader Extended PDF;  save an Opt im ized PDF;  

save the file as an I mage, MS Word or a Spreadsheet  file;  or one of the 

addit ional opt ions, such as PDF/ A, Rich Text  Format , HTML, XML or Plain Text . 

Share Files Using SendNow  Online  – requires a subscr ipt ion with Adobe©  

SendNow, a paid service. 

At tach to Em ail – adds the selected file(s)  to a message using the default  mail 

handler. 

Act ion W izard  – creates, edits or launches mult i-step Act ions to stream line 

workflows. 

Revert  – recovers the last saved version of the document . 

Close  – closes the current  f ile. 

Propert ies – displays the Document  Propert ies dialog box. 

Print  – opens the Pr int  dialog box. 

To use the tools on the Edit  m enu 

1. Click the Edit  menu (Alt  +  E) . 

2. The following opt ions are available:  

Undo – removes the previous edit . 

Redo – reapplies edits removed using Undo. 

Cut  – moves the select ion to the Clipboard. 

Copy  – copies the select ion to the Clipboard. 

Paste  – pastes the Cut or Copied content  from the Clipboard. 

Delete  – deletes select ion when using fill- in forms or the Typewriter tool. 

Select  All – selects all content  in the file. 

Deselect  All – deselects any selected content . 

Copy File to Clipboard – copies the ent ire file to the Clipboard. 

Take a  Snapshot  – copies a user-defined range to the Clipboard. 

Check Spelling – checks the spelling on editable text . 

Look Up Selected W ord – launches an on- line dict ionary. 

Find  – opens the Find dialog to search within the current  f ile. 

Advanced Search  – opens the Advanced Search dialog to perform  a search on 

the open or other files. 



Preferences – opens the Preferences dialog to control default  set t ings for 

Acrobat . 

To use the tools on the View  m enu 

1. Click the View menu (Alt  +  V) .  

2. The following opt ions are available:  

Rotate View  – displays a submenu to choose to rotate the current f ile 

clockwise or counterclockwise. 

Page Navigat ion  – displays a submenu of opt ions for navigat ing through the 

file. 

Page Display  – displays a submenu of opt ions for the current  display, 

including enabling automat ic scrolling and displaying Two Page View. 

Zoom  – displays a submenu with Zoom tools, including Fit  to Width or Actual 

Size, Pan & Zoom, the Loupe Tool ( to magnify the selected content  in a 

separate window) , and the Reflow tool, which reformats all text  into a single 

column to quickly view how it  will display on a web page or mobile device. 

Tools – allows you to quickly display one of the panels in the Tools pane. 

Com m ent  – allows you to quickly display one of the panels in the Comment  

pane. 

Share  – allows you to quickly display one of the panels in the Share pane. 

Show / Hide  – displays a submenu of interface elements, such as toolbars and 

menus, that  can be hidden or displayed. 

Read Mode  – displays the current  document  in Read Mode, hiding toolbars and 

task panes, with a float ing navigat ion bar for ease of reading on screen. 

Full Screen Mode – displays the current  document in Full Screen Mode, with 

no menus, toolbars, task panes or navigat ion bar.  Press Esc to return to 

regular v iew. 

Read Out  Loud  – displays a submenu of tools to act ivate and control the Read 

Out  Loud feature. 

Com pare Docum ents – launches the Compare Documents dialog to perform  a 

comparison of two PDF documents. 

To use the tools on the W indow  m enu 

1. Click the Window menu (Alt  +  W ) . 

2. The following opt ions are available:  

New  W indow  – opens a copy of the current  f ile in a new window. 

Cascade  – displays all open Acrobat  windows in a layered format . 

Tile  – offers the opt ions of displaying the open Acrobat windows hor izontally or 

vert ically. 

Minim ize All W indow s – m inim izes all open Acrobat windows to the taskbar. 

Split  – displays two copies of the same document  in an open window to perm it  

navigat ion to two places in the same file. 

Spreadsheet  Split  – displays the act ive document in four quadrants, which 

may be resized or rearranged, to allow for navigat ion to var ious port ions of the 

document .  This is designed for working with a file that  has column and row 

informat ion that  can remain on-screen while navigat ing through the contents. 

Rem ove Split  – removes the current  split  display, if any. 

To hide the Menu bar using the m enu m ethod 

1. Click the View menu (Alt  +  V) .  

2. Choose Show / Hide . 

3. Select  Menu Bar . 

To hide the Menu bar using keystrokes 

1. Press F9  on the keyboard. 

To restore the Menu bar  after hiding 

1. Press F9  on the keyboard. 

 

DOCUMENT PREFERENCES 

To restore the last  view  w hen reopening docum ents 

1. Click the Edit  menu in Acrobat  X. 

2. Choose Preferences (or press Ctrl +  K) . 

3. Select  Docum ents from  the Categories: pane. 

4. Place a checkmark next  to Restore last  view  set t ings w hen reopening 

docum ents. 

5. Click OK. 

To change the num ber of recent ly opened docum ents that  display 

in the Organizer History on the File  m enu 

1. Click the Edit  menu in Acrobat  X. 

2. Choose Preferences (or press Ctrl +  K) . 

3. Select  Docum ents from  the Categories: pane. 

4. Change the Docum ents in recent ly used list : by typing a new value or using 

the up or down arrows .  

5. Click OK. 

To autom at ically save a t im ed backup of the current  f ile 

1. Click the Edit  menu in Acrobat  X. 

2. Choose Preferences (or press Ctrl +  K) . 

3. Select  Docum ents from  the Categories: pane. 

4. Place a checkmark next  to Autom at ically save docum ent  changes to 

tem porary file every: and type the number of m inutes between saves. 

5. Click OK. 

To autom at ically exam ine docum ents for hidden data  

1. Click the Edit  menu in Acrobat  X. 

2. Choose Preferences (or press Ctrl +  K) . 

3. Select  Docum ents from  the Categories: pane. 



4. Place a checkmark next  to Exam ine docum ent  w hen closing docum ent  

and/ or Exam ine docum ent  w hen sending docum ent  by em ail. 

5. Click OK. 

To autom at ically renam e a Redacted version of a  file 

1. Click the Edit  menu in Acrobat  X. 

2. Choose Preferences (or press Ctrl +  K) . 

3. Select  Docum ents from  the Categories: pane. 

4. Place a checkmark next  to Adjust  file nam e w hen saving applied redact ion 

m arks. 

5. Type a default  Prefix  and/ or Suffix  for  all redacted file names. 

6. Click OK. 

 

GENERAL PREFERENCES 

To zoom  using the m ouse w heel 

1. Click the Edit  menu in Acrobat  X. 

2. Choose Preferences (or press Ctrl +  K) . 

3. Select  General from  the Categories: pane. 

4. Place a checkmark next  to Make Hand tool use m ouse- w heel zoom ing . 

5. Click OK. 

6. Press down on the mouse wheel and rotate up or down to zoom in or out . 

 

TOOLBARS 

To use the Quick Tools toolbar  

1. Click on one of the shortcut  but tons to launch a command. 

2. I f addit ional opt ions are available, a drop-down appears and a menu of choices 

appears. 

To custom ize the toolbar using the m enu m ethod 

1. Click the View menu (Alt  +  V) .  

2. Choose Show / Hide . 

3. Select  Toolbar I tem s. 

4. Select  a category from the submenu. 

5. Select  or deselect an item  from the list . 

6. As the toolbar area grows, addit ional shortcuts can be found by clicking the 

down-arrow to display more commands. 

To custom ize the toolbars using the r ight- click m ethod 

1. Right-click anywhere on the toolbar. 

2. Select  a category above the separator line. 

3. Select  or deselect an item  from the submenu. 

4. All items with checkmarks will appear on the toolbar. 

5. As the toolbar area grows, addit ional shortcuts can be found by clicking the 

down-arrow to display more commands. 

To custom ize the toolbars using the Custom ize Quick Tools icon 

1. Click the Custom ize Quick Tools icon  on the Quick Tools toolbar. 

2. Add commands from the left -hand pane by expanding a category and select ing 

an individual command. 

3. Press the Add but ton  to include the command in the r ight -hand pane (Quick 

Tools to Show: ) . 

4. Click OK. 

To reorder com m ands on the Quick Tools toolbar 

1. Click the Custom ize Quick Tools icon  on the Quick Tools toolbar. 

2. Highlight  an item  in the Quick Tools to Show:  pane. 

3. Click the Move Up  or Move Down  but ton to change the order of the 

commands. 

4. Click OK. 

To create groups on the Quick Tools toolbar  

1. Click the Custom ize Quick Tools icon  on the Quick Tools toolbar. 

2. Click on the I nsert  Separator icon . 

3. Use the Move Up  or Move Down  but ton to place the separator in the 

desired locat ion. 

4. Add commands to the new group using one of the methods descr ibed above. 

To custom ize the Quick Tools toolbar using the drag and drop 

m ethod 

1. Launch the Tools task pane by clicking on the  but ton. 

2. Hover over a command unt il a double-dashed vert ical line appears next  to the 

name. 

3. Single-click with the mouse and drag the command onto the Quick Tools 

toolbar. 

4. Release when the mouse displays a +  sign. 

To custom ize the Quick Tools toolbar using the r ight- click m ethod 

from  the task pane 

1. Launch the Tools task pane by clicking on the Show Tools pane but ton 

. 

2. Right-click on a command. 

3. Select  Add to Quick Tools. 

 

TASK PANES 

To display a task pane 

1. Click on the , , or  task pane launcher. 

To close a task pane 

1. Click again on the ,  , or   task pane launcher. 



2. Or , click the Opt ions Flyout   in the upper- r ight  corner of the Tools or 

Comment  task pane and choose Close Pane  from  the menu. 

To custom ize the panel display 

1. Click the Opt ions Flyout   in the upper- r ight  corner of the Tools or 

Comment  task pane. 

2. Select  or deselect panels from the list . 

3. All items with checkmarks will appear in the list  of available panels when the 

task pane is launched. 

To expand a panel and display com m ands 

1. Click on the  or   task pane launcher. 

2. Click on the expand but ton  next  to a category name. 

3. A list  of available commands is displayed. 

4. I f addit ional opt ions are available, a down-arrow  is displayed.  Click this 

arrow to display a menu of related commands. 

To collapse a panel 

1. Click on the down-arrow  to the left  of a category name. 

2. All commands are collapsed into the category name. 

To display m ult iple panels at  one t im e 

1. Click the Opt ions Flyout   in the upper- r ight  corner of the Tools or 

Comment  task pane. 

2. Select  Allow  Mult iple Panels Open . 

3. Click on the expand but ton  next  to each category name that  you wish to 

display. 

 

PAGE NAVI GATI ON 

To navigate using the Toolbar  

1. I f the Page Navigat ion Toolbar  is not  displayed, select the View  menu and 

choose Page Navigat ion . 

2. To move to the next  page, click on . 

3. To move to the previous page, click on . 

4. To move to a specific page, type the page number in the  box. 

To navigate using the keyboard 

1. Press the Page Up or  Page Dow n  key to move up or down one screen at  a 

t ime. 

2. Press Ctrl +  Page Up  or  Ctrl +  Page Dow n  to move to the top of the 

previous or next  page. 

3. Press the Hom e  key to move to the top of the file. 

4. Press the End key to move to the bot tom of the file. 

To navigate using the m enu 

1. Click on the View  menu. 

2. Choose Page Navigat ion . 

3. Select  from First  Page , Previous Page , Next  Page , Last  Page , or Page . 

4. When select ing Page , the Go To Page dialog opens. 

5. Type the page number. 

6. Click on OK. 

To navigate using Page Thum bnails 

1. Click on  to open the Page Thumbnails pane. 

2. Click on the thumbnail of a page to move to that  locat ion. 

3. The highlighted box on the thumbnail image corresponds to the area being 

displayed in the document  pane. 

 

READ MODE 

To view  the current  f ile  in Read Mode 

1. Click on the View File in Read Mode icon  in the upper- r ight  corner of the 

applicat ion. 

2. Toolbars and task panes are hidden and a float ing toolbar appears:  

 
3. The float ing toolbar only appears if the cursor is posit ioned in direct  proxim ity 

to it .  By default  it  is located at  the bot tom -center of the window. 

To m ove the float ing toolbar  

1. Hover the mouse pointer near the current  locat ion of the float ing toolbar unt il 

the pointer turns into a black arrow . 

2. Click and drag the float ing toolbar to the desired locat ion. 

3. Navigate away from the toolbar and it  will disappear. 

To navigate w hile  in Read Mode 

1. Click on the up-   or  down-arrow  on the float ing toolbar. 

2. Or , type a page number in the Go to a  specific page  box  

(Ctrl +  Shift  +  N ) . 

3. Or , use the keyboard shortcuts Page Up , Page Dn , + , or - . 

4. Or , click on the View menu and select  from  the Page Navigat ion opt ions. 

To zoom  in or out  w hile  in Read Mode 

1. Click on the –  or +   icons on the float ing toolbar. 

2. Or , click on the View menu and select  from  the Zoom opt ions. 



To save w hile  in Read Mode 

1. Press the Save icon   on the float ing toolbar.  

2. Or , click on the File menu and select Save . 

To print  w hile  in Read Mode 

1. Press the Pr int  icon  on the float ing toolbar. 

2. Or , click on the File menu and select Print . 

To close Read Mode 

1. Press the Close icon  on the float ing toolbar. 

2. Or , press the Esc key on the keyboard. 

3. Or , click on the View menu and deselect  Read Mode (Ctrl +  H ) . 

 

RETURN TO MAI N MENU



CREATE PDF FI LES

CREATE PDF FROM MENU- BASED APPLI CATI ON 

To create a PDF using the Menu Method 

1. Open the file in the nat ive applicat ion. 

2. Select  the Adobe PDF menu. 

3. Choose Convert  to Adobe PDF. 

4. Update the File Nam e  and Save I n  locat ion 

5. Click on Save . 

To create a PDF using the One- Click But ton Method 

1. Open the file in the nat ive applicat ion. 

2. Click on . 

3. Update the File Name and Save I n locat ion. 

4. Click on Save . 

To create a PDF using the Print  to PDF W ith Printer Driver Method 

1. Open the file in the nat ive applicat ion. 

2. Select  the File  menu. 

3. Choose Print . 

4. Click on the Printer Nam e  drop-down and choose Adobe PDF. 

5. Make any desired select ions from the Print  Dia log and click on OK. 

To create a PDF and Send For Review  using the  Menu Method 

1. Open the file in the nat ive applicat ion. 

2. Select  the Adobe PDF menu. 

3. Choose Convert  to Adobe PDF and Send for Review . 

4. Update the File Nam e  and Save I n  locat ion and click on Save . 

5. When the wizard begins, highlight  the file to send for review and click on Next . 

6. I nvite Review ers by typing in the e-mail address(es) or select ing from an 

address book and click on Next . 

7. Preview the e-mail invitat ion and make any modificat ions needed. 

8. Click on Send I nvitat ion . 

9. After the reviewer has made comments and returns the file, open the 

at tachment  from your e-mail I n Box. 

10. Click on Yes to merge the reviewer’s comments into the or iginal f ile;  click on 

No, open this copy only  to open a copy of the or iginal f ile. 

To create a PDF and Send For Review  using the  One- Click But ton 

Method 

1. Open the file in the nat ive applicat ion. 

2. Click on . 

3. Update the File Nam e  and Save I n  locat ion and click on Save . 

4. When the wizard begins, highlight  the file to send for review and click on Next . 

5. I nvite Review ers by typing in the e-mail address(es) or select ing from an 

address book and click on Next . 

6. Preview the e-mail invitat ion and make any modificat ions needed. 

7. Click on Send I nvitat ion . 

8. After the reviewer has made comments and returns the file, open the 

at tachment  from your e-mail I n Box. 

9. Click on Yes to merge the reviewer’s comments into the or iginal f ile;  click on 

No, open this copy only  to open a copy of the or iginal f ile. 

 

CREATE PDF FROM W ORD/ EXCEL/ POW ERPOI NT 2 0 0 7  

To create a PDF using the Office but ton 

1. Open the file in the nat ive applicat ion. 

2. Click on the Office but ton .  

3. Hover the mouse pointer over the Save As command. 

4. Select  Adobe PDF. 

5. Click on Convert  to PDF. 

 

CREATE PDF FROM OFFI CE 2 0 1 0  

To create a PDF using the File m enu/ Backstage View  

1. Open the file in the nat ive applicat ion. 

2. Click on the File tab. 

3. Click on Save &  Send . 

4. Select  Create Adobe PDF. 

 

CREATE A PDF MAI L MERGE 

To m erge W ord data into individual PDF files 

1. Set  up your Mail Merge by creat ing the form document and the recipient  list  in 

Word. 

2. I n Word 2003 and below, select  Mail Merge from the Adobe PDF menu. 

3. I n Word 2007 and above, select   from  the Create and Em ail group on 

the Acrobat  tab of the Ribbon. 

4. Select  the Record range  in the Acrobat  PDFMaker -  Mail Merge  dialog. 

5. Specify a PDF File Nam e . 

6. I f desired, choose Autom at ically send Adobe PDF files by Em ail and 

custom ize the To:, Subject  line , and Message  blocks. 



7. Click OK. 

 

CREATE PDF W I THOUT OPENI NG THE ORI GI NAL FI LE 

To create a PDF from  any rem ovable or hard drive locat ion 

1. Select  My Com puter ;  or  r ight - click  on the Start  menu and choose Explore 

(or , Open W indow s Explorer  in Windows 7) . 

2. Navigate to the folder containing the file(s)  to be converted. 

3. Select  the file name;  use CTRL- Click  to select  addit ional f iles. 

4. Right - click  on the file name(s) . 

5. Select  Convert  to Adobe PDF. 

6. Update the File Nam e  and Save I n  locat ion and click on Save . 

Note:   Only compat ible file types will convert . 

 

CONVERT ELECTRONI C FI LE TO PDF W I THI N ACROBAT 

To create a PDF version of an electronic file  from  w ithin Acrobat  

1. Click on  from the Acrobat  Welcome Screen. 

2. Or , select the File  menu and choose Create PDF. 

3. Or , click on  from the toolbar and choose PDF from  File . 

4. Browse to the locat ion of the file to convert . 

5. Click on Open . 

6. Adobe launches the or iginal applicat ion and converts the file using the default  

Conversion Set t ings stored with that  applicat ion. 

7. The converted file opens in Acrobat . 

 

CREATE PDF FROM W EBSI TE 

To create a PDF version of a  w ebsite from  w ithin Acrobat  

1. Select  the File  menu. 

2. Choose Create PDF. 

3. Or , click  from  the toolbar. 

4. Select  PDF From  W eb Page  (or  press Shift  +  Ct r l +  O) . 

5. Type or paste the URL or select  the Brow se  but ton to select  the website. 

6. Click  Capture Mult iple Levels to select  linked pages. 

7. I ndicate the number of levels to include or select  Get ent ire site .   

Note:  Select ing Get  ent ire site  for  a large website such as Amazon.com may 

require a substant ial amount  of t ime and storage space and may crash your PC. 

8. You may select  to Stay on sam e path  and/ or Stay on sam e server  to avoid 

following links that  are stored on other paths or servers. 

9. Click Create . 

To create a PDF file  from  a w ebsite from  a w eb brow ser  

1. Launch the site you wish to capture. 

2. Select  the Adobe PDF Toolbar , if it  is not already displayed. 

3. Click the  but ton. 

4. Begin clicking on areas of the website you want  to convert to PDF.  Before 

select ing an area, a box of red dots will appear.  Once you have selected the 

block of content , the dots will appear as blue. 

5. Click the  but ton again to turn off the Select  feature. 

6. Click on  to automat ically convert selected content  to PDF. 

7. Click the drop-down arrow to make addit ional select ions from the menu. 

 

ACCESS THE CONVERSI ON SETTI NGS/ PREFERENCES 

To access the Create PDF Opt ions in Office 2 0 0 3  and Out look 2 0 0 7  

1. Click on the Adobe PDF menu. 

2. Choose Change Conversion Sett ings. 

3. Click on the Conversion Set t ings drop-down from the Sett ings tab. 

4. Select  an opt ion from the list . 

To access the Create PDF Opt ions in W ord, Pow erPoint  and Excel 

2 0 0 7  and Office 2 0 1 0  

1. Click on the Acrobat  tab. 

2. Click on  from the Create Adobe PDF group of the Acrobat  Ribbon. 

 

ADD SECURI TY 

To add passw ord security to open a PDF docum ent  

1. Follow the steps for accessing the conversion set t ings/ preferences, above. 

2. Click on the Security  tab. 

3. Check Require a  passw ord to open the docum ent . 

4. Type a password in the Docum ent  Open Passw ord box. 

5. Retype the password in the confirmat ion dialog box. 

To restr ict  edit ing or print ing of a  PDF docum ent  

1. Follow the steps for accessing the conversion set t ings/ preferences, above. 

2. Click on the Security  tab. 

3. Click the box under Perm issions. 

4. Type a password in the Change Perm issions Passw ord  box. 

5. Choose a pr int ing opt ion:   Not  Allow ed, High Resolut ion  or Low  

Resolut ion . 

6. Make a select ion from the Changes Allow ed drop-down:  

None—no edit ing of the PDF file is perm it ted. 

I nsert ing, Delet ing and Rotat ing of Pages – the recipient  may replace or 

rotate exist ing PDF pages. 

Filling in of form  fields and signing –  the recipient  may move through the 

PDF file to fill in form fields and apply a digital signature only. 



Com m ent ing, filling in of form  fields, and signing –  the recipient  may use 

the Comment  and Markup tools in addit ion to the perm issions noted above. 

Any except  ext ract ing of pages –  the recipient  may use all available Acrobat  

tools, but  may not  remove pages from the file. 

7. Click on OK. 

8. Retype the password when prompted. 

 

CONVERT W ORD FEATURES 

To autom at ically convert  W ord com m ents to notes in PDF 

1. Click on the W ord  tab. 

2. Place a checkmark next  to Convert  displayed comments to notes in Adobe PDF. 

3. Click on OK. 

To autom at ically convert  W ord features to links 

1. Click on the W ord  tab. 

2. Place a checkmark next  to the item(s)  to be converted to links. 

3. Click on OK. 

To autom at ically convert  W ord features to Bookm arks in PDF 

1. Click on the Bookmarks tab. 

2. Place a checkmark next  to the item(s)  to be converted to Bookmarks:  

Convert  W ord Headings to Bookm arks –  converts Headings 1 through 9 to 

Bookmarks in the PDF file. 

Convert  W ord Styles to Bookm arks –  converts all applied Styles to 

Bookmarks in the PDF file. 

Convert  W ord Bookm arks –  converts all Bookmarks in the or iginal Word file 

to Bookmarks in the PDF file. 

3. Place a checkmark next  to individual Style names to convert  them to 

Bookmarks. 

4. Deselect  any checked items that  should not  have a corresponding Bookmark 

created in the PDF file. 

5. Click on OK. 

6. Click on OK. 

 

NOTE:  All Preferences changed in the nat ive applicat ion become the default  

conversion opt ions for any of the “Convert  to PDF”  methods descr ibed above. 

 

CREATE PDF FROM SCANNER 

To create a PDF from  hard copy using a connected scanner 

1. Select  the File  menu. 

2. Choose Create PDF. 

3. Or , click  from  the toolbar. 

4. Choose PDF from  Scanner to display a submenu. 

5. Choose one of the Presets from the list . 

To custom ize the scanner presets 

1. Select  the File  menu. 

2. Choose Create PDF. 

3. Or , click  from  the toolbar. 

4. Choose PDF from  Scanner to display a submenu. 

5. Select  Configure Presets. 

6. Click in the Presets drop-down to select  an opt ion. 

7. Make changes to the I nput  and Document  Set t ings. 

8. Click on Save . 

9. The next  t ime that  Preset  is selected, the new defaults will be applied. 

 

CREATE PDF FROM CLI PBOARD 

To create a PDF file  from  the contents of the clipboard 

1. Select  the File  menu. 

2. Choose Create PDF. 

3. Or , click  from  the toolbar. 

4. Select  PDF From  Clipboard . 

5. The contents of the clipboard are automat ically placed into a new PDF file. 
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COMBI NE FI LES

SELECT FI LES TO COMBI NE I NTO A SI NGLE PDF 

To select  m ult iple files for inclusion into a single PDF file from  

w ithin Acrobat  

1. Select  the File menu, choose Create and select  Com bine Files into a  Single 

PDF…  

2. Or , click  from  the toolbar. 

3. Com bine Files into a  Single PDF… 

4. Click on  to display the Add Files menu. 

5. Choose Add Files to select  individual f iles in their current  format . 

6. Browse to the locat ion of the desired content . 

7. Select  the file or press Ctrl- Click to select  mult iple files and click Add Files. 

8. Choose Add Folders to select all of the contents of specific folder.  Note, only 

files that  are in a compat ible file format  will be converted using this method.   

9. Choose Reuse Files to select recent ly selected files or folders. 

10. Choose Add Open Files to include current ly open PDF files. 

11. Alternat ively, you may use Drag and Drop  to select  f iles from any folder 

locat ion to place them in the list . 

To select  m ult iple files for inclusion into a single PDF from  outside 

of Acrobat  

1. Explore to the saved file locat ion. 

2. Press Ctrl +  Click  to select  mult iple files in the same folder. 

3. Right - click  on the selected file(s) . 

4. Select  Com bine Supported Files in Acrobat… 

5. All compat ible files are displayed in the Combine Files pane. 

To add an ent ire folder to a single PDF file 

1. Explore to the desired folder. 

2. Right - click  on the folder name. 

3. Select  Com bine Supported Files in Acrobat… 

4. All compat ible files stored in the selected folder are listed individually in the 

Combine Files pane. 

 

ARRANGE FI LES I N THE COMBI NED PDF 

To arrange the selected files in the order in w hich they should 

appear in the new  PDF file 

1. Click on a file name in the Combine Files pane, or Ctrl- Click  to select mult iple 

files. 

2. Select   or   to reorder the selected file(s) . 

3. Select   to delete the file(s)  from  the list . 

 

 

SELECT PORTI ONS OF FI LES 

To include or exclude specific pages from  a W ord or PDF docum ent  

1. Click on the Word or PDF document  in the Add Files pane. 

2. Click on . 

3. A preview of the document  is displayed. 

4. Select  the Page Range by typing the desired page numbers in the Pages: box. 

5. Type individual pages, separated by a comma, and/ or type a page range 

separated by a hyphen.  Do not  include spaces.  E.g., 1 ,3 ,8 - 1 4 ,2 2 . 

6. Click OK. 

7. Press .  

To include or exclude specific sheets from  an Excel f ile 

1. Click on the Excel spreadsheet  in the Add Files pane. 

2. Click on . 

3. The Preview  and Select  Sheets dialog opens. 

4. Click a worksheet to select it  for inclusion in the combined file. 

5. Use the Move Up  and/ or Move Dow n  but tons to determ ine the order of each 

sheet  in the combined PDF file. 

6. Click OK. 

7. Press .  

 

To include or exclude specific slides from  a Pow erPoint  f ile 

1. Click on the PowerPoint  f ile in the Add Files pane. 

2. Click on . 

3. The Preview  and Select  Slides dialog opens. 

4. I ndicate the Range of slides to be included in the combined file. 

5. Use the Move Up  and/ or Move Dow n  but tons to determ ine the order of each 

sheet  in the combined PDF file. 

6. Click OK. 

7. Press .  

 



COMBI NE FI LES 

To create the PDF file 

1. After select ing the files and clicking on , the files will be 

opened in their  nat ive applicat ion(s) , if applicable, and converted to PDF. 

2. The Merging Files pane will update as each file is converted. 

3. Check the W arnings/ Errors area of the Com bine  pane to ver ify that  all f iles 

were successfully converted and/ or combined. 

4. The combined PDF file will open in Acrobat  with a display name of “Binder”  

followed by a number. 

5. Click on File  and then Save  (or , press Ctrl +  S)  to rename the combined file or 

to select  a locat ion for  the file.  The combined file is not saved automat ically. 
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PORTFOLI OS

CREATE A PDF PORTFOLI O 

To create a PDF port folio 

1. Select  the File menu, choose Create and select  PDF Port folio.  

2. Or , select  and select  PDF Port folio. 

3. Or , click on  from the Acrobat Welcome Screen. 

To select  a  port folio layout  

1. After creat ing the port folio, choose a layout from the list  of provided opt ions. 

2. Or , click on . 

3. The preview pane displays a sample of the selected layout . 

4. Click  to proceed to a blank port folio. 

Note:  The Port folio Welcome Screen, int roduced in Acrobat 9, is not supported 

in Acrobat X. 

To add files w hen creat ing the port folio 

1. After creat ing the port folio, click on . 

2. Browse to the locat ion of the file(s)  to be included in the port folio. 

3. Select  the file(s)  and click on Open . 

To add files after the port folio has been created 

1. Expand the  panel. 

2. Choose to Add Files, Add Folder , or  Add W eb Content . 

3. Browse to the locat ion of the file(s)  to be included in the port folio. 

4. Select  the file(s)  and click on Open . 

To add files using Drag and Drop 

1. Create a port folio using the steps above. 

2. Open another window which contains the file(s)  you wish to include in the 

Port folio. 

3. Using the mouse, click and drag the file(s)  into the Portfolio window and 

release. 

Note :   You must  be in Layout  v iew to drag and drop files into the Port folio. 

To save or renam e a Port folio 

1. Click  to launch the Save As dialog box. 

 

PREVI EW  FI LES 

To preview  a file contained in a Port folio 

1. Double-click on a file in the Layout  v iew. 

2. An enlarged view of the current  f ile is displayed . 

To extract  a  file  from  a Port folio 

1. Hover the mouse pointer over the bot tom-center of the file preview to display a 

float ing toolbar. 

2. Click on  to extract  the act ive file. 

3. I ndicate a file name and locat ion for  the extracted file. 

4. Select  Save . 

To show  the info view  on a file in a Port folio 

1. Hover the mouse pointer over the bot tom-center of the file preview to display a 

float ing toolbar. 

2. Click on . 

3. The file name, size, date modified and other informat ion is displayed. 

To close the info view  

1. Click on  while in info view. 

To open a preview ed file  in its original applicat ion 

1. Click on  in the upper- r ight  corner of the preview window. 

2. Make a select ion from the advisory message and click OK. 

To close the Preview  view  

1. Click the  in the upper r ight corner of the previewed file. 

 



FOLDERS 

The use of Folders inside of a Port folio will help organize the content . 

To create a new  folder w ithin a Port folio 

1. Expand the  panel on the Layout  task pane. 

2. Select  Create Folder . 

3. Enter a Name for the folder. 

4. Click OK. 

To m ove files into folders 

1. I f the file is already contained in the Port folio, select  the file with the mouse 

and drag it  over the folder. 

2. Release the mouse and the file is moved into the folder. 

To edit  the contents of a  folder 

1. Double- click  on the folder. 

2. Click on a file in the Folder and press Delete  to remove it  from  the folder. 

3. Use the r ight - click  command to display an extensive menu of addit ional 

opt ions. 

4. Press  to navigate back to the previous window. 

5. Or, press  to close the folder preview. 

 

VI SUAL THEMES 

To apply a visual them e to a Port folio 

1. Expand the  panel on the Layout  task pane. 

2. Select  one of the default  themes to apply it  to the Port folio;  or , click on I m port  

Custom  Them e… and browse to the custom theme locat ion. 

To change a Port folio’s visual them e  

1. Expand the  panel on the Layout  task pane. 

2. The current  v isual theme is highlighted;  select  another theme from the list . 

 

COLOR PALETTES 

To change the Port folio’s color palet te  

1. Expand the  panel on the Layout  task pane. 

2. The Current  Palet te is displayed at the top of the list . 

3. Click on one of the available palet tes to apply coordinated backgrounds, font  

colors, and borders. 

4. Click on the Create from  Exist ing but ton to define the Port folio’s Background, 

Border, Pr imary, Accent , and Text  colors. 

 

BACKGROUND 

To custom ize the Port folio Background color  

1. Expand the  panel on the Layout  task pane. 

2. Click the  icon to select  a background color. 

3. Select  the gradient  sty le and intensity, if desired. 

To apply a Background im age 

1. Expand the  panel on the Layout  task pane. 

2. Click the Background I m age  drop-down. 

3. Choose New  to browse for a stored image;  or select  a previously applied 

image from the list . 

 

PORTFOLI O PROPERTI ES 

To custom ize the Port folio font  

1. Display the Layout  task pane. 

2. The Portfolio Propert ies pane displays at  the bot tom of the list  of available 

panels. 

3. Click in the Font  drop-down to select  the default  font . 

4. The default  font  is applied to the Port folio – this is the font  used for displaying 

the file name(s) and I nfo screen(s) . 

To em bed fonts in the Port folio 

1. Click the Em bed fonts check box. 

2. All fonts will be embedded in the port folio, result ing in a larger file, but more 

consistent  results for  the recipients. 

 

PORTFOLI O HEADER 

To add a Port folio header 

1. Click in the blank area at  the top of the Portfolio. 

2. The Portfolio Propert ies pane is replaced with the Header Propert ies pane. 

To apply a header tem plate 

1. Click in the Tem plates drop-down. 

2. Select  an item  from the list  to apply it . 

3. Placeholders are added for the elements selected ( text  or images) . 

To set  the header’s background color  

1. Click in the header area. 

2. Click the  icon in the Background Color  area. 

3. Click in the drop-down to select  a solid or gradient  f ill.  

4. Use the Background Opacity  slider to control the background appearance. 



To add header item s 

1. Click the  or  but ton in the Header I tems panel of the 

Header Propert ies pane. 

2. Depending on the item  selected, click in the Propert ies area to anchor the 

image or text . 

To custom ize header text  

1. Double-click on the text  box placeholder in the header. 

2. Type or paste the contents of the text  header. 

3. Change the text propert ies from the Text field propert ies pane. 

4. Click away from the text  box to apply the changes. 

To resize header item s 

1. Click on an item in the header. 

2. Click one of the corner or side handles and drag to resize. 

To m ove a header item  

1. Click on an item in the header. 

2. Drag the item  to the desired locat ion. 

To rem ove a header item  

1. Click on an item in the header. 

2. Select  Rem ove  from the Propert ies pane. 

 

FI LE DETAI LS 

To select  the colum ns that  display in Preview  m ode 

1. Click on the Details task pane. 

2. Place a checkmark next  to each column you wish to display. 

3. Deselect  columns that  you do not  want  to display. 

To add custom  colum ns 

1. Type a name in the Add a colum n  box. 

2. Click in the column type drop-down and choose Text , Num ber , or Date . 

3. Click the  icon to add the custom column. 

To set  the init ia l colum n sort  

1. Change the I nit ial Sort  order of the files in the Port folio by clicking in the 

drop-down and choosing the Column heading on which to sort . 

To view  the file  details in a list  

1. Click the  but ton on the toolbar. 

2. Click the  but ton on the toolbar. 

3. The selected columns are displayed, sorted on the I nit ial Sort  order. 

To change the sort  order of the default  colum n 

1. Click the  but ton next to the column name to reverse the sort  order. 

To change the default  colum n for sort ing 

1. Click the  but ton on the toolbar. 

2. Select  a different  column name from the I nit ial Sort  drop-down in the Details 

pane. 

 

PREVI EW  PORTFOLI O 

To view  the port folio as it  w ill appear w hen shared 

1. Click the  but ton on the toolbar. 

2. Click the  but ton. 

 

SHARE PORTFOLI O 

To share the Port folio using Adobe SendNow  Online 

1. Save the Port folio (select  the File  menu and choose Save Port folio, or  press 

Ctrl +  S) . 

2. Click on the Share task pane. 

3. Select  Use Adobe SendNow  Online . 

4. Click the Add File  link and browse to the Port folio. 

5. Type an email address in the To… box;  or click on the To... link to launch a list  

of contacts. 

6. Type a Subject  and Message .  

7. Click on Send Link . 

Note:  You must  create an account  to use this service. 

To share the Port folio by at taching to em ail 

1. Save the Port folio (select  the File  menu and choose Save Port folio, or  press 

Ctrl +  S) . 

2. Click on the Share task pane. 

3. Select  Attach to Em ail. 

4. Click the Add File  link and browse to the Port folio. 

5. Type an email address in the To… box;  or click on the To... link to launch a list  

of contacts. 

6. Click on  to launch an email message with the Port folio at tached. 

7. Address and send the message. 

To share the Port folio by saving 

1. Select  the File  menu and choose Save Port folio (or press Ctrl +  S) . 

2. To select  a new locat ion for the Port folio, select  the File  menu and choose 

Save As (or press Shift  +  Ctrl +  S) .  

3. I ndicate a shared locat ion or removable dr ive. 



4. Dist r ibute a link to or physical copy of the Port folio;  or , at tach the Port folio to a 

standard email message. 
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EDI T PDF FI LES

I NSERT PAGES I NTO A PDF FI LE 

To add pages to a PDF file 

1. Open the file into which you want  to add other PDF page(s) . 

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Choose . 

5. Select  the file which contains the page(s)  you wish to insert . 

6. Click on . 

7. I ndicate the desired placement  for  the inserted page(s) . 

8. Click on OK. 

9. All pages of the inserted file are included.  Use the steps below to delete 

specific pages if they are not needed. 

10. Save  the file. 

 

CREATE BLANK PDF I N ACROBAT 

To create a PDF from  a blank page in Acrobat  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Click on the drop-down arrow  next  to More I nsert  Opt ions. 

4. Select  I nsert  Blank Page  (or click Shift  +  Ct rl +  Q) . 

5. To type onto the blank page, use the Typew riter tool as descr ibed below. 

 

I NSERT CLI PBOARD CONTENTS I NTO A PDF FI LE 

To add the contents of the clipboard into the open PDF 

1. Open the file into which you want  to add the contents of the clipboard. 

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Click the  drop-down. 

5. Choose I nsert  from  Clipboard . 

6. I ndicate the desired placement  for  the inserted content . 

7. Click on OK. 

8. Save  the file. 

 

REMOVE PAGES FROM A PDF FI LE 

To delete pages from  a PDF file 

1. Open the PDF file which contains the page(s)  to be deleted. 

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Choose . 

5. I ndicate the page(s) to delete. 

6. Click on OK. 

7. Press Yes to confirm  the delet ion. 

8. Save  the file. 

To extract  pages from  a  PDF file 

1. Open the PDF file which contains the page(s)  to be deleted. 

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Choose . 

5. I ndicate the page(s) to ext ract .  

6. Place a checkmark next  to Delete Pages After Ext ract ing to remove them 

from the current  f ile. 

7. Place a checkmark next  to Ext ract  Pages As Separate Files to move each 

ext racted page into its own PDF file. 

8. Click on OK. 

9. The extracted page(s)  open in a new window. 

10. The new file is named “Pages from  xxx ”  (where xxx is the or iginal PDF file 

name) . 

11. Rename, if desired. 

 

REPLACE PAGES I N A PDF FI LE 

To replace PDF pages w ith those from  another PDF file 

1. Open the file into which you want  to add other PDF page(s) . 

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Choose . 

5. Select  the file which contains the page(s)  you wish to insert . 

6. I ndicate the pages to be replaced in the Original File . 

7. I ndicate the pages with which to replace them from the Replacem ent  File . 



8. Click on OK. 

9. Press Yes to confirm  the delet ion 

10. Save  the file. 

 

CROP PDF CONTENT 

Cropping a PDF does not  reduce the file size because informat ion is merely hidden, 

not  discarded. 

To crop em pty areas around a page 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Draw a rectangle on the page you want  to crop. 

5. Double-click inside the rectangle to open the Set  Page Boxes dialog. 

6. Under Margin Controls, select Rem ove W hite Margins. 

7. Click on OK. 

To crop one or m ore pages 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Double-click inside the rectangle to open the Set  Page Boxes dialog. 

5. I n the pop-up menu in the upper left  corner, leave CropBox  selected. 

6. Adjust  values for the Margin Controls:   Top, Bot tom, Left , and Right . 

7. As needed, specify Page Range  set t ings. 

8. Click on OK. 

To undo cropping 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Double-click inside the rectangle to open the Set  Page Boxes dialog. 

5. Select  Set  to Zero to restore all margins for the current ly act ive Margin Control 

(CropBox, ArtBox, Tr imBox, or BleedBox) . 

6. Repeat  for  addit ional Margin Controls, if cropping was applied. 

7. Click on OK. 

 

SPLI T A PDF FI LE 

To split  one or m ore open PDF files 

1. Open one of the PDF files to be split .  

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Choose . 

5. Specify the cr iter ia desired for split t ing the document :  

Num ber Of Pages - -  Specify the maximum number of pages for each 

document  in the split  

File Size - -  Specify the maximum file size for  each document  in the split .  

Top-Level Bookm arks - -  I f the document  contains bookmarks, this opt ion will 

create one document  for every top- level bookmark. 

6. Click on OK to perform  the split  and click OK again to clear the status dialog. 

To split  PDF files from  a blank Acrobat  w indow  

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Click on  in the Split  Docum ents window. 

5. Select  the file(s)  on which you want  to perform the split .  Note:  All f iles must  

be in PDF format . 

6. Or, you may use Drag and Drop  to drag files into the Split  Docum ents 

window. 

7. Click OK when ready to perform  the split . 

8. Specify the cr iter ia desired for split t ing the document :  

Num ber Of Pages - -  Specify the maximum number of pages for each 

document  in the split  

File Size - -  Specify the maximum file size for  each document  in the split .  

Top-Level Bookm arks - -  I f the document  contains bookmarks, this opt ion will 

create one document  for every top- level bookmark. 

9. Click on OK to perform  the split  and click OK again to clear the status dialog. 

To change the Split  Docum ent  Opt ions 

1. Select  the file(s)  to be split , using one of the methods above. 

2. I n the Split  Docum ent  dialog, click on . 

3. To specify a target  folder for  the split  f iles, select  The Sam e Folder Selected 

at  Start  or A Folder on My Com puter . 

4. To specify file name preferences, choose one or more of the opt ions in the File 

Labeling group. 

5. Click OK. 

To apply the split  docum ent  opt ions to m ult iple PDF files 

1. Click on  to apply the same split  document  preferences to 

mult iple documents.   

2. The Split  Docum ents window opens and you may Add Files or  Folders. 

3. Click on OK to perform  the split  and click OK again to clear the status dialog. 

 



EDI T CONTENT I N  PDF FI LES 

To edit  PDF text  

Note:  The file must  be an “editable”  PDF (either created from a supported file type 

or “ recognized”  using the tools on the  panel of the Tools task 

pane) . 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Click the Edit  Docum ent  Text  command. 

4. Click and drag the text  you wish to edit .  Selected text  will be highlighted. 

5. I f the or iginal fonts are not  available, an advisory message will display.  Click 

on OK. 

6. Begin typing to replace the exist ing text . 

7. Turn off text edit ing by clicking the Select  Object  but ton on the Content  panel, 

or by clicking the select ion tool  on the toolbar.  

8. Save  the file. 

To insert  text  using the Typew riter tool 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Click the Add or Edit  Text  Box  command. 

4. The Typewriter toolbar appears. 

5. Posit ion the mouse pointer at  the locat ion where the text  is to be inserted and 

click. 

6. Begin typing and the text  is placed in a text  box. 

7. Turn off the Typewriter  tool by clicking the Select  Object  but ton on the 

Content  panel, or  by clicking the select ion tool  on the toolbar;  or  close the 

Typewriter toolbar by clicking the “X”  in the upper- r ight  corner.  

To m ake changes to the  Typew riter tool defaults 

1. Display the Typewriter  toolbar, as descr ibed in steps 1-4, above. 

2. Posit ion the mouse pointer at  the locat ion where the text  is to be inserted and 

click. 

3. Select  one of the font  size, line spacing, or text color shortcuts found on the 

toolbar in order to change the appearance of the typed text . 

4. Click on the Font  drop-down to select  a different  font . 

5. Click on the Font  Size drop-down to change the font  size. 

6. Begin typing the text into the new text  box. 

7. Turn off the Typewriter  tool by clicking the Select  Object  but ton on the 

Content  panel, or  by clicking the select ion tool  on the toolbar;  or  close the 

Typewriter toolbar by clicking the “X”  in the upper- r ight  corner.  

To edit  PDF im ages 

1. The file must  be “editable”  PDF (either created from a supported file type or 

“ recognized”  using the tools on the  panel of the Tools task 

pane) . 

2. Click on the  task pane. 

3. Expand the  panel. 

4. Click the Edit  Object  command. 

5. Select  the object by clicking on it . 

6. Delete by pressing the Delete  key, or drag to resize or reposit ion the object . 

7. Right - click  on the image for a menu of addit ional choices. 

8. Choose Place I m age to insert  a new image at  the selected locat ion. 

 

ROTATE PAGE( S)  

To rotate the current  page 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click on . 

4. Select  a Direct ion  from  the drop-down list . 

5. Click on OK. 

To rotate m ult iple pages 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click on . 

4. Select  a Direct ion  from  the drop-down list . 

5. I ndicate a Page Range . 

6. Click on OK. 

 

CONVERT PDF TO W ORD OR EXCEL 

To save a file to MS W ord 

1. Open the PDF file in Acrobat . 

2. Click the File  menu. 

3. Select  Save As… 

4. Click on Microsoft  W ord  to display the available file formats. 

5. Select  W ord Docum ent  to save in the newer .docx format . 

6. Select  W ord 9 7 - 2 0 0 3  Docum ent  to save in the older .doc format . 

7. Type a name and locat ion in the Save As dialog box. 

8. Click on Save . 

To save a file to MS Excel 

1. Open the PDF file in Acrobat . 

2. Click the File  menu. 



3. Select  Save As… 

4. Click on Spreadsheet  to display the available file formats. 

5. Select  Microsoft  Excel W orkbook . 

6. Type a name and locat ion in the Save As dialog box. 

7. Click on Save . 

 

COPY PDF I MAGE I NTO OTHER APPLI CATI ONS 

To insert  PDF content  as an im age into another  applicat ion 

1. Open the PDF file which contains the content . 

2. Select  the Edit  menu. 

3. Choose Take a  Snapshot . 

4. Click and drag the mouse pointer in a rectangle surrounding the area to be 

copied. 

5. Acrobat  automat ically copies the content  to the Clipboard. 

6. Open the applicat ion where the content  is to be placed. 

7. Select  the Edit  menu (or the Paste  command on the Home tab in Office 

2007/ 2010) . 

8. Choose Paste Specia l… 

9. Click on OK. 

 

I NSERT PDF I NTO OTHER APPLI CATI ONS 

To insert  a  PDF page into another applicat ion 

1. Open the applicat ion where the PDF content  is to be placed. 

2. Select  the I nsert  menu (or the I nsert  tab in Office 2007/ 2010 applicat ions) . 

3. Choose Object . 

4. Select  the Create from  File  tab. 

5. Browse for and select  the PDF file you wish to insert . 

6. Click Link to file  if you want  the object  to automat ically update when the 

or iginal PDF file is changed. 

7. Click on OK. 

 

RETURN TO MAI N MENU



DOCUMENT PROCESSI NG

BOOKMARKS 

To navigate using Bookm arks 

1. Click on  to open the Bookmarks pane. 

2. Click on a bookmark to move to that  locat ion in the file. 

To expand the current  Bookm ark  

1. Click on  to open the Bookmarks pane. 

2. Click on a Bookmark. 

3. Click the  icon to expand the current  Bookmark. 

4. OR, click on  to expand the current  Bookmark. 

5. OR, click on the Opt ions but ton  and choose Expand Current  

Bookm ark . 

 

To set  a  new  Dest inat ion for a  Bookm ark 

1. Click in the file at the new locat ion for  the Bookmark. 

2. Click on  to open the Bookmarks pane. 

3. Right-click on the Bookmark’s name. 

4. Choose Set  Dest inat ion . 

5. Click Yes to confirm . 

To create a new  Bookm ark 

1. Click on  to open the Bookmarks pane. 

2. Highlight  the area in the PDF file that  will serve as the Dest inat ion for  the new 

Bookmark. 

3. Click on . 

4. The new Bookmark will either be named Unt it led  or will contain the text  that  

was selected. 

5. Edit  the name, if necessary. 

To renam e a Bookm ark  

1. Click on  to open the Bookmarks pane. 

2. Right-click on the Bookmark’s name. 

3. Choose Renam e . 

4. Type a new name for the Bookmark. 

To reorder Bookm arks 

1. Click on  to open the Bookmarks pane. 

2. Click and drag a bookmark name. 

3. The mouse pointer turns into a t r iangle followed by a dashed line while it  is 

being dragged to a new locat ion. 

4. Release the mouse when the indicator is in the desired locat ion. 

 

W ATERMARKS 

To access the Add W aterm ark dialog 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click the  drop-down. 

4. Select  Add W aterm ark . 

To create a new  text  W aterm ark  

1. Open the Add Watermark dialog, as descr ibed above. 

2. Select  the Text  radio but ton. 

3. Type the desired text in the text  ent ry box. 

4. Make select ions in the Appearance and Posit ion categor ies. 

5. Click on OK. 

To create an im age W aterm ark  

1. Open the Add Watermark dialog, as descr ibed above. 

2. Select  the File radio but ton. 

3. Click the Brow se… but ton to select  the file.   

Note:  only PDF, JPEG and BMP file formats may be used as Watermarks. 

4. Make select ions in the Appearance and Posit ion categor ies. 

5. Click on OK. 

To save set t ings 

1. Create and format a Watermark using one of the methods above. 

2. Click the Save Sett ings… but ton. 

3. Type a name for the Save Sett ings. 

4. Click on OK. 

To apply a saved W aterm ark on the act ive file 

1. Open the file on which to place the saved Watermark. 

2. Open the Add Watermark dialog, as descr ibed above. 

3. Click in the Saved Set t ings drop-down. 



4. Choose a name from the list . 

5. All saved propert ies are displayed. 

6. Click on OK to apply to the current  document . 

To apply a saved W aterm ark on m ult iple docum ents 

1. Open the Add Watermark dialog, as descr ibed above. 

2. Click in the Saved Set t ings drop-down. 

3. Choose a name from the list . 

4. All saved propert ies are displayed. 

5. Click on Apply to Mult iple . 

6. Select  f iles by clicking on . 

7. Browse and select  f iles. 

8. Click on OK. 

9. Make select ions from the Output  Opt ions dialog and click on OK. 

To specify page ranges for a  W aterm ark 

1. Apply a Watermark, using one of the methods above. 

2. Click the Page Range Opt ions… link. 

3. Specify the page range for the Watermark placement . 

4. Click on OK. 

 

FI ND AND SEARCH 

To locate text  using Find 

1. Click on the Edit  menu. 

2. Select  Find (or, press Ctrl +  F) . 

3. Type the text  in the  box which opens at the top of the 

document  window. 

4. Press Enter  or  click on  to jump to the first  instance of the text . 

5. Press  to find the previous instance of the text . 

6. Press  to find the next instance of the text . 

To close the Find dialog box 

1. Click the  in the r ight -hand margin of the Find dialog box. 

To locate text  using Search 

1. Click the  next  to the Find box. 

2. Select  Open Full Acrobat  Search… 

3. I ndicate the word or phrase to search for. 

4. Select  the locat ion and other specific search cr iter ia. 

5. Click on Search . 

6. The Results pane displays all instances of the Search term . 

7. Click on an ent ry in the Results pane to jump direct ly to that  locat ion. 

SAVE SEARCH 

To save a Search 

1. Locate all instances of the text  using the Search feature descr ibed above. 

2. Select  the Save icon  located next  to the New Search but ton. 

3. Choose to Save Results as PDF or  Save Results as CSV . 

4. I ndicate a file name and locat ion and click on Save . 

5. The search results are saved for future reference. 

To perform  a New  Search 

1. After using the Search feature as descr ibed above, click the New  Search  

but ton. 

2. The Results pane disappears and the or iginal Search dialog is displayed. 

3. I ndicate the word or phrase to search for. 

4. Select  the locat ion and other specific search cr iter ia. 

5. Click on Search . 

 

HEADER AND FOOTER 

To add a Header and Footer  

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Select  Add Header &  Footer… 

5. Click the Page Num ber and Date Form at… link to define the numbering or 

date style(s) . 

6. Place the cursor in one of the Header or Footer locat ions:   Left , Right  or Center. 

7. Click the I nsert  Page Num ber  but ton to include automat ic page numbering. 

8. Click the I nsert  Date  but ton to include a date stamp. 

9. Place the cursor in any of the Header or Footer locat ions and type or paste 

custom text .  Mult iple lines of text  ent ry may be entered in the placeholders. 

10. Click on OK. 

11. Examine the results in the Preview area. 

12. I f desired, change the Font  or Margins;  the preview automat ically updates. 

13. Click on OK to apply the set t ings to the current  document , or click on Apply to 

Mult iple  to select  addit ional documents for insert ion of the selected Header 

and Footer set t ings. 

To add a Header and Footer to a range of pages 

1. Follow steps 1-9, above. 

2. Click the Page Range Opt ions… link. 

3. I ndicate the page range for the current  set t ings. 

4. Click on OK. 

To custom ize the Header and Footer opt ions 

1. The Preview  window at  the bot tom of the Add Header and Footer dialog 

displays the current  set t ings for headers and footers. 



2. Margins appear as dashed lines. 

3. Change the margins, measured in inches from the edge of the paper, by 

clicking in the Top: , Bot tom: , Left :  or  Right :  dialog box and typing a new 

measurement ;  or , click the scroll but tons to adjust the margins. 

4. Change the font  and font  size for  the Header and Footer by select ing from the 

drop-downs. 

5. Click on to under line the Header or Footer informat ion.  Click again to 

toggle the under lining off. 

6. Click on  to open the font  color box and apply a different  font  color. 

7. Click the Appearance Opt ions link. 

8. Place a checkmark to act ivate either or both opt ions:  

Shrink docum ent  to avoid overw rit ing the docum ent ’s text  and graphics 

–  reduces the or iginal document ’s size ( including exist ing headers and footers) 

to avoid placing the Header or Footer on top of exist ing content . 

Keep posit ion and size of header/ footer text  constant  w hen print ing on 

different  page sizes –  the Header or Footer will be placed in the same 

locat ion regardless of the or iginal document ’s layout  or paper size. 

9. Click on OK. 

To delete all Headers and Footers 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Select  Rem ove… 

5. Click on Yes to permanent ly remove the Header and Footer informat ion. 

 

BATES NUMBERI NG 

To select  f iles 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Select  Add Bates Num bering… 

5. Click on  to display the Add Files menu. 

6. Choose Add Files to select  individual f iles of compat ible format  ( f iles do NOT 

need to be in PDF format  to add them to the list ) . 

7. Browse to the locat ion of the desired content . 

8. Click the Add Files of Type  drop-down to select  specific f ile formats. 

9. Select  the file or press Ctrl +  Click to select  mult iple files and click Add Files. 

10. Choose Add Folders to select all of the contents of specific folder.  Note, only 

files that  are in a compat ible file format  will be converted using this method.   

11. Highlight  the files to which Bates Numbering should be applied and click Add . 

12. Bates Numbering will be applied to the files in order of appearance in the Bates 

Numbering pane. 

13. Click on a file name. 

14. Select   or   to reorder the selected file(s) . 

15. Select   to delete the file(s)  from  the list . 

16. Click OK. 

To custom ize the Bates Num bering opt ions 

1. The Preview  window at  the bot tom of the Add Header and Footer dialog 

displays the current  set t ings for headers and footers. 

2. Margins appear as dashed lines. 

3. Change the margins, measured in inches from the edge of the paper, by 

clicking in the Top: , Bot tom: , Left :  or  Right :  dialog box and typing a new 

measurement ;  or , click the scroll but tons to adjust the margins. 

4. Change the font  and font  size for  the Bates Numbering by select ing from the 

drop-downs. 

5. Click on to under line the Bates Numbering informat ion.  Click again to 

toggle the under lining off. 

6. Click on  to open the font  color box and apply a different  font  color. 

7. Click the Appearance Opt ions link. 

8. Place a checkmark to act ivate either or both opt ions:  

Shrink docum ent  to avoid overw rit ing the docum ent ’s text  and graphics 

–  reduces the or iginal document ’s size ( including exist ing headers and footers) 

to avoid placing the Bates Numbering on top of exist ing content .  

Keep posit ion and size of header/ footer text  constant  w hen print ing on 

different  page sizes –  the Bates Numbering will be placed in the same 

locat ion regardless of the or iginal document ’s layout  or paper size. 

9. Click on OK. 

To insert  Bates Num bering 

1. Place the cursor in one of the Header or Footer locat ions:   Left , Right  or Center. 

2. Click I nsert  Bates Num ber… 

3. I nsert  the Number of Digits for  the Bates Number ( the value must  be between 

3 and 15) . 

4. Change the Start  Number, if necessary. 

5. I nsert  a Prefix or Suffix, if desired. 

6. Click on OK. 

7. Click on OK again to apply the numbering to all selected documents. 

8. An advisory message displays the number of pages to which the automat ic 

headers and/ or footers have been applied.   

9. Click OK again. 

To rem ove Bates Num bering from  an open docum ent  

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose . 

4. Select  Rem ove… 

5. Click on OK. 



To rem ove Bates Num bering from  a set  of docum ents 

1. Close any open PDF documents. 

2. Click on the  task pane. 

3. Click on  to expand the panel. 

4. Choose . 

5. Select  Rem ove… 

6. Click on  to display the Add Files menu. 

7. Choose Add Files to select  individual f iles from which you want  to remove 

Bates Numbering or other automat ically applied Headers or Footers. 

8. Click OK. 

9. A results message displays. 

10. Click on OK again. 

 

MULTI MEDI A 

To add m ult im edia to a PDF docum ent  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  the Video , Sound , SWF , or  3D  tool. 

5. Drag a rectangle or double-click on the area where you want  the mult imedia 

object  to appear. 

6. Type the file name or click on Brow se… to insert  a file;  or , insert  a URL that  

refers to a video file or st ream ing media. 

7. The following are the most common file types that  are direct ly compat ible with 

Acrobat  X:   FLV, FV4, mp3, and SWF.  Other file formats may need to be 

converted before being placed into a PDF file. 

8. Three types of URL addresses may be inserted:   RMTP, HTTP, and HTTPS. 

To custom ize the m ult im edia opt ions 

1. Click the Show  Advanced Opt ions checkbox when insert ing the file name. 

2. Or, r ight -click on the mult imedia object and choose Propert ies. 

3. Make select ions from the opt ions found in the Act ivat ion Set t ings or 

Appearance  groups on the Launch Set t ings tab. 

To delete a m ult im edia object  

1. Right-click the object  to select it .  A solid border appears. 

2. Press the Delete  key on the keyboard. 

 

RETURN TO MAI N MENU



COLLABORATI ON

COMPARE DOCUMENTS 

To com pare tw o PDF docum ents 

1. Select  the View  menu. 

2. Choose Com pare Docum ents… 

3. Specify the two documents to be compared (Com pare ( older docum ent )  and 

To ( new er docum ent ) ) . 

4. I f necessary, indicate the page range(s)  for  each document . 

5. I ndicate the Docum ent  Descript ion  that  best descr ibes the types of 

documents you are comparing. 

6. Click OK. 

 

REVI EW  COMPARI SONS 

To display the Com pare results 

1. After running the comparison, a results document  appears with the Com pare  

panel open.  The displayed document  contains the name of the NEW  document  

with a prefix of [ Com pare New ] . 

2. The first  page of the NEW  document  contains a Sum m ary  of the comparison 

results. 

3. A Color  Legend appears in both the NEW  and OLD  documents to provide 

informat ion about  the annotat ions. 

4. I f the Color Legend does not  appear, click on the Opt ions  drop-down in 

the Compare panel and choose Show  Color Legend . 

5. Click on  to close the Color Legend ;  or , select  Hide Color Legend from  

the Opt ions  drop-down. 

To hide or show  annotat ions 

1. To hide the annotat ions that  display changes, click  or choose Hide 

Results from the Options  drop-down. 

2. To show the annotat ions that  display changes, click  or choose 

Show  Results from the Opt ions  drop-down. 

3. Toggle between  and  to indicate which elements 

should be displayed (Text , I mages, Headers/ Footers, etc.)  or to display 

thumbnails of the two files. 

To show  each file  in its ow n w indow  

1. Select  the Opt ions  drop-down. 

2. Choose Show  Docum ents Tiled  or Show  Docum ents Side by side . 

3. Synchronize the two documents by choosing Synchronize Pages.  As you 

navigate through one of the files, the other will display the same area in the 

compared file. 

To w ork w ith thum bnails 

1. Click on a page thumbnail to navigate direct ly to that  page. 

2. Change the size of thumbnails by choosing Thum bnail size  from the Opt ions 

 drop-down and choose Sm all Thum bnails, Medium  Thum bnails or 

Large Thum bnails.  Medium Thumbnails are displayed by default . 

3. By default , the NEW  document  thumbnails are displayed in the Compare panel.  

Drag the split ter bar at  the bot tom of the panel up to display the thumbnails of 

the OLD document . 

4. Click a thumbnail from the OLD document  to open it  in a new window. 

5. The comparison is not automat ically saved.  Before closing, save or pr int  a copy 

if needed. 

 

COMMENTS 

To add com m ents to a PDF file 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click on  to act ivate the Add st icky note  tool (or , press Ctrl +  6 ) . 

4. The mouse pointer turns into the St icky Note tool.  Click the pointer at  the 

locat ion where you want  to place the St icky Note. 

5. Type the comment . 

6. Minim ize the St icky Note pop-up by clicking on the  in the upper- r ight  corner 

of the message. 

To delete com m ents from  a PDF file 

1. Click once on the comment  indicator  to select  it . 

2. Press the Delete  key. 

 



HI GHLI GHT TOOL 

To add highlight ing 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click the  tool. 

4. Drag the mouse pointer over the area to highlight . 

5. Double-click on the highlighted text  to insert  comments into the pop-up. 

To delete highlight ing 

1. Double-click the highlighted area to open the pop-up. 

2. Click on the Opt ions drop-down. 

3. Select  Delete . 

4. Or, r ight -click on the highlighted area and select  Delete . 

 

ATTACH FI LE 

To at tach a file  as an annotat ion 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click the  tool. 

4. The mouse pointer turns into the At tach File tool.  Click the pointer at  the 

locat ion where you want  to reference the at tached file. 

5. Browse to the locat ion of the file and select  it . 

To edit  the appearance of the at tached file  indicator  

1. Attach a file, as descr ibed above. 

2. After select ing the file, choose one of the icons from the Appearance tab of the 

File At tachment  Propert ies dialog box.  The choices are:  

 

3. Click on OK. 

To see inform at ion about  an at tached file 

1. Hover the mouse pointer over the at tached file icon. 

2. The Author and File Name appear in the informat ion box. 

To open an at tached file 

1. Double-click the at tached file icon. 

2. The at tachment  opens in its nat ive format . 

To m ove the at tached file  icon 

1. Single-click on the icon to select  it . 

2. Drag the icon to the desired locat ion and release. 

To delete an at tached file 

1. Click once on the at tached file icon. 

2. Press Delete . 

3. Or, r ight -click on the icon and choose Delete . 

 

AUDI O COMMENTS 

To record an audio com m ent  

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click the  tool. 

4. Click the Record  but ton on the Sound Recorder dialog and speak into a 

connected m icrophone.  Note:   8 seconds of recording t ime is available. 

To insert  an audio com m ent  from  a file 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click the  tool. 

4. Click the Brow se… but ton to locate the audio file. 

5. Click on OK. 

To edit  the appearance of the audio com m ent  indicator  

1. I nsert  an audio comment , using one of the methods above. 

2. After select ing a file (or recording audio) , choose one of the icons from the 

Appearance tab of the Sound At tachment  Propert ies dialog box.  The choices 

are:  

 

3. Click on OK. 

 



STAMPS 

To add a stam p annotat ion 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Click the  tool to display a menu of opt ions. 

4. Select  a category or displayed stamp. 

5. Click on the stamp and complete the informat ion requested in the dialog box, if 

any. 

6. Click where you want  the stamp to appear on the page. 

To delete a stam p 

1. Click once on the stamp icon. 

2. Press Delete . 

3. Or, r ight -click on the stamp and choose Delete . 

 

TEXT EDI TS 

To act ivate the text  edit  tools 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Choose one of the following tools:  

 

click at  a locat ion and type new text  which will be placed in 

a comment  box (or, use the I nsert  key) 

 

click and drag across text  to display a st r ikethrough effect  

and open a comment  box for new text  (or , use the I nsert  

key) 

 

click and drag across text  to display a st r ikethough effect 

without  opening a comment  box (or, use the Delete  key)  

 

click and drag across text  to apply under lining 

 

Click and drag across text  to apply highlight ing and open a 

comment  box for the placement  of notes related to the 

highlighted text 

To deselect  an annotat ion tool 

1. After select ing one of the annotat ion tools, it  may remain act ive unt il another 

tool is selected. 

2. Turn off annotat ion tools by clicking the select ion tool  on the toolbar. 

DRAW I NG MARKUPS 

To add a Draw ing Markup  

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Select  the type of markup you wish to apply. 

 

 

The Line tool, the Arrow tool, the Oval tool, and the Rectangle 

tool let  you create simple shapes. 

Tip:  Hold the Shift  key when using the Rectangle tool to 

create a Square.  Hold the Shift  key when using the Oval tool 

to create a Circle. 

 

The Cloud tool and Polygon tool create closed shapes with 

mult iple segments. 

 

The Polygon Line tool creates open shares with mult iple 

segments. 

 

The Pencil tool creates free-form  drawings and the Eraser tool 

removes the pencil markups. 

4. Draw in the PDF by clicking to create the start  point  and dragging to end the 

end point  for  simple shapes.   

5. For mult iple segment  drawings, click to create the start  point  move the pointer 

and click to create each segment . 

6. For free- form  drawings, drag where you want  to begin drawing and release the 

mouse but ton.  Move the pointer to a new locat ion and cont inue drawing. 

To add a Text  Box 

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Select  the Add Text  Box   tool.  

4. Click and drag in the PDF to place the text  box. 

5. Click inside the text  box and type the text . 

To add a Text  Callout  

1. Click on the  task pane. 

2. Click on  to expand the panel. 

3. Select  the Add Text  Box  Click on the  task pane. 

4. Click on  to expand the panel. 

5. Select  the Add Text  Callout   tool. 



6. Click once in the PDF to place the start ing point  for  the arrow of the text  callout  

box. 

7. Posit ion the mouse pointer at  the locat ion where the callout  box should be 

placed and click again. 

8. Click inside the text  box and type the text . 

To change Text  Box or Callout  propert ies 

1. Right-click on an inserted Text  Box or Text  Callout . 

2. Choose Propert ies. 

3. On the Appearance  tab, change the Line Thickness, Style, Fill Color, Border 

Color and/ or Opacity, as desired. 

4. Place a checkmark in Make Propert ies Default  if desired. 

5. Click OK. 

To delete a Draw ing Markup 

1. Click once on the markup. 

2. Press Delete ;  or , r ight -click and choose Delete  from the menu. 

 

I N I TI ATE SHARED REVI EW  

To create a PDF and invite  collaborat ion from  other applicat ions 

1. Open the file in the nat ive applicat ion. 

2. Select  the Adobe PDF menu (Office 2003)  or Acrobat  tab (Office 2007/ 2010) . 

3. Choose  (Office 2003)  or 

 (Office 2007/ 2010) . 

4. The Send for Shared Review  wizard begins. 

5. I ndicate how you want  to collect  comments from your reviewers:  

Autom at ically dow nload &  t rack com m ents w ith Acrobat .com  - -  this 

method will ut ilize the free shared server locat ion provided by Adobe to licensed 

users. 

Autom at ically collect  com m ents on m y ow n internal server - -  this method 

requires a shared space, such as a SharePoint  server or network locat ion, 

where you can receive and collect  reviews. 

6. Complete the steps in the wizard to send the invitat ion to reviewers. 

7. When using Acrobat .com, note the choices in Access Level:  

Open access: - -  this opt ion provides access to anyone who knows the URL. 

Lim ited access: - -  this opt ion provides access only to those individuals who 

receive the email invitat ion. 

8. An e-mail message with the PDF file as an at tachment  will be handed to your 

default  mail server. 

To send a PDF file  and invite  collaborat ion via shared review  

1. Open the PDF file in Acrobat . 

2. Open the  panel. 

3. Select  Send for Shared Review . 

4. Follow steps 4-8 above. 

To send a PDF file  and invite  collaborat ion via em ail 

1. Open the PDF file in Acrobat . 

2. Open the  panel. 

3. Select  Send for Em ail Review . 

4. The I nit iat ing Em ail- Based Review  wizard launches. 

5. Specify the file to be sent .  By default , the open file name is inserted into the 

ent ry box. 

6. Click Next  >  to cont inue through the wizard to send the invitat ion to reviewers. 

7. Custom ize the I nvitat ion message, if desired. 

8. Click on . 

9. An e-mail message with the PDF file as an at tachment  will be handed to your 

default  mail server. 

 

PARTI CI PATE I N  SHARED REVI EW  

To add com m ents and m arkup to a shared review  

1. Review the inst ruct ions that  were automat ically included in the e-mail message. 

2. Click on the document  link to Download the file. 

3. Open the file in Acrobat  (Reader or above) . 

4. Click on  or  to access the review tools 

as descr ibed ear lier in this sect ion (or use the tools on the Review toolbar, if 

using Acrobat  9 Reader or earlier  to part icipate in the review) . 

5. I nsert  comments or other annotat ions. 

6. Click the  but ton to post  your comments to the server. 

To add com m ents and m arkup to an em ail review  

1. Review the inst ruct ions that  were automat ically included in the e-mail message. 

2. I f the Adobe Acrobat Reader is not  loaded on the computer, download it  using 

the link provided in the e-mail message. 

3. Open the file in Acrobat  (Reader or above) . 

4. Click on  or  to access the review tools 

as descr ibed ear lier in this sect ion (or use the tools on the Review toolbar, if 

using Acrobat  9 to part icipate in the review) .. 

5. I nsert  comments or other annotat ions. 

6. Click the  but ton to send the annotated file back to the 

or iginator as an email at tachment . 

 



TRACK SHARED REVI EW S 

To check for new  com m ents in a shared review  

1. The or iginator of the review may check for new comments by clicking on the 

 but ton in the shared file. 

2. I f new comments have been added, an advisory message appears. 

3. Click on the link to accept  all comments and include them in the shared file. 

To use the review  t racker 

1. Open the  panel. 

2. Select  Track Review s… 

3. Select  the name of a review from the list  at  the left . 

4. Use the links in the main panel to view comments or add reviewers. 

 

SHOW  COMMENTS LI ST 

To display all com m ents and m arkup in a list  form at  

1. Open the  panel. 

2. Click on  to sort  the Comments by Type , Page , Author  or  other cr iter ia. 

3. Click on  to filter the Comments by Type , Review er , Status or other 

cr iter ia. 

4. Click the Opt ions but ton  to display a menu of addit ional opt ions for 

working with the Comments. 

 

MANAGE AND MERGE COMMENTS 

To sum m arize all com m ents 

1. I f the Comments List  panel is not  already open, click on Show  Com m ents 

List . 

2. Click the Opt ions but ton . 

3. Select  Create Com m ent Sum m ary . 

4. Choose a layout . 

5. Click on . 

To add a checkm ark to a com m ent  

1. I f the Comments List  panel is not  already open, click on Show  Com m ents 

List . 

2. Click on a comment  in the Comments List . 

3. Click the box next to the comment . 

4. Comments can be sorted or f iltered based on added checkmarks. 

To change the status of com m ents 

1. Right-click on a comment  in the Comments List . 

2. Click on Set  Status in the Comments List  toolbar. 

3. Choose Migrat ion  or Review . 

4. Set  the status for the comment .  

 

EXPORT COMMENTS TO W ORD 

To export  PDF com m ents to W ord 

1. The or iginal document  must have been created in Word. 

2. Click the Opt ions but ton . 

3. Select  Export  to W ord… 

4. Browse to Choose the Files. 

5. Select  the Comment  Types to import . 

6. Click Cont inue . 

7. The file opens in Word with the comments indicated with Word’s Reviewing 

tools. 
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DOCUMENT SECURI TY

REMOVE HI DDEN I NFORMATI ON 

To check the act ive file for hidden content  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose Rem ove Hidden I nform at ion… 

4. The Rem ove Hidden I nform at ion pane displays a Status of the process. 

5. Checkmarks are placed next  to each type of item which appears in the file. 

6. Click on to expand a category for  more informat ion. 

7. Uncheck any items which should not  be removed. 

8. Click on  to remove all checked items. 

9. Click on OK. 

10. Press  to save the file without  the hidden content .  (Note, you will be 

prompted to enter a new file name, if desired.)   

11. Click on  to close the Rem ove Hidden I nform at ion pane. 

 

SANI TI ZE DOCUMENT 

To sanit ize the act ive file  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose Sanit ize Docum ent . 

4. A full list  of all items that  will automat ically be removed is display. 

5. Click on OK. 

6. All listed items are automat ically removed from the file, without  offer ing the 

user the opt ion to deselect  any of the items. 

7. Save the file, using a new name if desired. 

 

EXAMI NE ALL FI LES 

To autom at ically exam ine files w hen closing 

1. Select  the Edit  menu. 

2. Choose Preferences.  

3. Select  Docum ents in the Categories: pane. 

4. Place a checkmark next  to Rem ove Hidden I nform at ion w hen closing 

docum ent . 

5. Click on OK. 

6. Each t ime a document  is closed, the Remove Hidden I nformat ion dialog is 

launched.  Follow the steps out lined in “Remove Hidden I nformat ion,”  above. 

To autom at ically exam ine files w hen sending by em ail 

1. Select  the Edit  menu. 

2. Choose Preferences.  

3. Select  Docum ents in the Categories: pane. 

4. Place a checkmark next  to Rem ove Hidden I nform at ion w hen sending 

docum ent  by em ail. 

5. Click on OK. 

6. Each t ime a document  is at tached to an email from within Acrobat , the Remove 

Hidden I nformat ion dialog is launched.  Follow the steps out lined in “Remove 

Hidden I nformat ion,”  above. 

 

REDACTI ON 

Redact ing content  permanent ly removes it  from the file.  I t  cannot  be discovered or 

recovered after the file is saved.  I f a copy of the or iginal content  is needed, be sure 

to save the redacted version with a new file name. 

To display the Redact ion tools 

1. Click on the  task pane. 

2. Expand the  panel. 

 

REDACTI ON PROPERTI ES 

To change the redact ion defaults 

1. Click on . 

2. Click on  to select a different  Redacted Area Fill Color . 

3. Place a checkmark next  to Use Overlay Text  to replace the redacted content  

with text  instead of a solid color box. 

4. Select  a Font  and Font  Size from the Overlay Text  area. 

5. Place a checkmark next  to Auto- Size text  to fit  redact ion region  to overr ide 

the font size. 

6. Click on the Font  Color  but ton to change the color of the Over lay Text . 

7. Place a checkmark next  to Repeat  Overlay Text  if you want  the text  to be 

repeated as many t imes as needed to cover the redact ion region.  Leave it  

unchecked if you want  the Over lay Text referenced only once;  the default  f ill 

color will cover the redacted area. 

8. Click one of the Text  Alignm ent  but tons to control the layout  of the Over lay 

Text . 



9. Click the Custom  Text  radio but ton and type the custom text  in the box. 

10. I f the redact ion is subject  to a specific provision of the Freedom of I nformat ion 

Act  or the Pr ivacy Act , click the Redact ion Code  radio but ton. 

11. Choose the appropr iate Code Set . 

12. Select  a Code Ent ry . 

13. Click Edit  Codes to add or revise the Code Sets. 

14. Make changes and click on OK. 

15. Click OK to close the Redact ion Tool Propert ies. 

 

MARK FOR REDACTI ON 

To m ark areas for redact ion 

1. Click on  to act ivate the tool. 

2. Click and drag the mouse over the area to be redacted. 

3. Release the mouse. 

4. I f desired, double-click on the marked area and type the reason for the 

redact ion in the Comments & Markup pop-up box. 

5. Close the pop-up by clicking on  in the upper- r ight  corner. 

To select  a  w ord for redact ion 

1. Click on  to act ivate the tool. 

2. Double-click a word to select  it .  

To select  a  rectangle for  redact ion 

1. Click on  to act ivate the tool. 

2. Hold down the Ctrl key while dragging the mouse to select  a rectangle. 

Redact  across pages 

1. Click on . 

2. Use one of the methods above for indicat ing a redact ion area. 

3. Right-click on the redact ion mark. 

4. Select  Repeat  m ark across pages. 

5. Select  a page range. 

6. Click on OK. 

7. The redact ion area will be repeated on the selected pages. 

 

SEARCH AND REMOVE TEXT 

To autom at ically m ark specific text  for redact ion 

1. To use the Search and Remove Text  feature, the text must  be recognizable by 

Acrobat , such as in an editable PDF. 

2. Click on . 

3. Click OK after  reading the advisory message. 

4. I ndicate whether to search I n the current  docum ent  or choose All PDF 

Docum ents in, and indicate the locat ion for the search. 

5. Select  Single w ord or phrase  and type in the “What  word or phrase would 

you like to search for?”  box. 

6. Click on Search and Redact . 

7. Each occurrence of the search term is listed in the Results pane. 

8. Click on Check All or  place a checkmark next  to individual instances of the 

search term to mark them for redact ion. 

9. Click on Mark Checked Results for Redact ion . 

10. Apply the redact ions, as above. 

To autom at ically search for text  pat terns 

1. To use the Search and Remove Text  feature, the text must  be recognizable by 

Acrobat , such as in an editable PDF. 

2. Click on . 

3. Click OK after  reading the advisory message. 

4. Select  Patterns. 

5. Click in the Select  your pat tern  drop-down. 

6. Choose from the pre-defined search pat terns. 

7. Click on Search and Redact . 

8. Each occurrence of the search term is listed in the Results pane. 

9. Click on Check All or  place a checkmark next  to individual instances of the 

search term to mark them for redact ion. 

10. Click on Mark Checked Results for Redact ion . 

11. Apply the redact ions, as above. 

 

REDACT ENTI RE PAGE( S)  

To m ark ent ire page( s)  for redact ion 

1. Click on . 

2. Select  the page(s)  to redact . 

3. Click on OK. 

 

APPLY REDACTI ONS 

To apply redact ions 

1. Click on . 

2. An advisory message appears.  Click on OK. 

3. After applying the redact ions, Acrobat  offers to find and remove hidden 

informat ion in the document .  Click Yes to perform the scan or click No to skip 

it .  

4. I f the scan is performed, follow the steps in “Remove Hidden I nformat ion,”  

above. 

 



DOCUMENT PROTECTI ON 

To encrypt  a  PDF docum ent  w ith a passw ord 

1. Open the PDF file in Acrobat . 

2. Click on the  task pane. 

3. Expand the  panel. 

4. Click on the Encrypt  drop-down. 

5. Select  Encrypt  w ith Passw ord . 

6. Click on Yes to cont inue. 

7. Select  the Com pat ibility  version, which determ ines the Encrypt ion Level. 

8. Select  which Docum ent  Com ponents to Encrypt . 

9. Select  the type of Passw ord  to require:   to open the document  or to rest r ict  

edit ing and pr int ing of the document . 

10. Type the password. 

11. The st rength meter displays to the r ight  of the password. 

12. Click on OK. 

13. Confirm  the password. 

14. Click on OK. 

15. The advisory message indicates that  the secur ity set t ings will not  be applied 

unt il you close the file. 

16. Click on OK. 

To rem ove or change passw ord protect ion 

1. Enter the password when prompted. 

2. Click on the  task pane. 

3. Expand the  panel. 

4. Click on the Encrypt  drop-down. 

5. Select  Rem ove  or  Manage  to change password opt ions. 

 

DI GI TAL SI GNATURE 

To create a digita l I D 

1. I f you do not already have a digital I D, create a self-signed digital I D in Acrobat  

by clicking on the  task pane. 

2. Expand the  panel. 

3. Click on the More Sign &  Cert ify  drop-down. 

4. Choose Security Set t ings. 

5. Select  Digita l I Ds from the menu on the left . 

6. Click the  but ton. 

7. Select  A new  digita l I D I  w ant  to create now . 

8. Select  Next  > . 

9. Fill in the personal informat ion for your digital I D and cont inue through the 

wizard. 

10. I nsert  and confirm your password and click Finish . 

To digita lly sign a docum ent  

1. Carefully review the document  in Preview Document  mode to see all dynam ic 

content  that  may be contained in the file. 

Tip:  To use Preview Document  mode, open the Preferences dialog and select  

Security  on the left ;  then, select  View  docum ents in preview  docum ent  

m ode w hen signing . 

2. Check each page of a document  for  signature fields.  You may need to sign a 

document  in more than one place. 

3. Click the signature field, if there is one. 

4. Or , click on the  task pane. 

5. Expand the  panel. 

6. Select  Sign Docum ent . 

7. Draw a signature field on the page. 

8. Make any necessary changes in the Sign Document  dialog box. 

9. Enter the password for the digital signature. 

10. Click on Sign . 
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FORMS

CREATE FORM 

To create a form  from  an exist ing electronic docum ent  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  Use an exist ing file . 

5. Click on Next  > . 

6. Either select Use the current  docum ent  or I m port  a file from  file system .  

I f import ing a file, click on Brow se… to locate the exist ing document . 

7. Click in the Files of type: drop-down and choose the file format  of the exist ing 

document  if it  is not displayed. 

8. Highlight  the document  and click on Open . 

9. Click on Next  > . 

10. A copy of the file will be converted to PDF, if it  is current ly in another format . 

11. Click OK to close the Form Edit ing Mode message. 

12. Click on  to name and save the form . 

To create a form  from  a scanned docum ent  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  Scan a paper form . 

5. Click on Next  > . 

6. Choose a Scanner and Scan Format . 

7. Cont inue through the Wizard to scan and save the paper document . 

 

EDI T FORM 

After creat ing a form , the  task pane is displayed, along with a var iety of 

form  edit ing tools on the toolbar. 

To add guidelines 

1. Display the Ruler. 

2. I f the Ruler is not  current ly displayed, select  the View  menu, then choose 

Show / Hide  and Rulers &  Grids, and select  Rulers. 

3. Drag down from the hor izontal ruler to create a hor izontal guide, or drag to the 

r ight  of the vert ical ruler to create a vert ical guide. 

4. Or, double-click a locat ion on the hor izontal ruler to create a vert ical guide, or 

double-click a locat ion on the vert ical ruler to create a hor izontal guide. 

To m ove a guideline 

1. Click the guide to select  it  and drag it  to the new posit ion. 

To delete guidelines 

1. Click the guide and press Delete . 

2. To remove all guides, r ight -click in the ruler and choose Clear Guides on Page  

or Clear All Guides. 

To display the grid 

1. Select  the View  menu, then choose Show / Hide  and Rulers &  Grids. 

2. Select  Grid . 

To add a form  fie ld 

1. Expand the  panel. 

2. Click on the  drop-down. 

3. Select  the type of f ield you want  to add. 

4. Or, choose a form field from the toolbar. 

5. Place the selected field type to the desired posit ion. 

6. Type the Field Nam e . 

7. Click the All Propert ies link to change the appearance or other propert ies of 

this object . 

8. Drag a corner of the text  box to resize or reposit ion. 

To set  tab order  

1. Click on  in the  task pane. 

2. Choose one of the pre-defined sort  orders. 

3. Or, select  Order tabs m anually . 

4. Click a field in the list  and drag and drop it  into the desired order. 

To m ake a fie ld required 

1. Double-click an object  that  you want  to make a required field. 

2. Select  the General tab. 

3. Place a checkmark in the Required  box. 



To test  a  form  

1. Click on . 

2. You can now fill in the form as the user would to see if you need to make any 

changes. 

3. Return to form edit ing by clicking on . 

4. Save . 

 

DI STRI BUTE FORM 

To dist r ibute a form  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. The Send for Shared Review  wizard begins. 

5. I ndicate how you want  to collect  comments from your reviewers:  

Autom at ically dow nload &  organize responses w ith Acrobat .com  - -  this 

method will ut ilize the free shared server locat ion provided by Adobe to licensed 

users.  Recipients of the file do not need an Acrobat .com account  to part icipate 

in the review. 

Manually collect  responses in m y em ail inbox – this method allows you to 

send a form  as an at tachment using Acrobat or your mail client .  Recipients can 

use Acrobat  or Reader to fill in the form .  Acrobat  copies each response into a 

master response file as they are returned. 

Autom at ically collect  com m ents on m y ow n internal server - -  this 

method requires a shared space, such as a SharePoint  server or network 

locat ion, where you can receive and collect reviews. 

6. Complete the steps in the wizard to send the invitat ion to reviewers. 

7. When using Acrobat .com, note the choices in Access Level:  

Open access: - -  this opt ion provides access to anyone who knows the URL . 

Lim ited access: - -  this opt ion provides access only to those individuals who 

receive the email invitat ion. 

8. An e-mail message with the PDF file as an at tachment  will be handed to your 

default  mail server. 

9. Acrobat .com t racks the responses entered into the form  by all recipients. 

 

ADOBE FORMS CENTRAL 

To create an online form  using Adobe Form sCentral  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  the Create or edit  a  form  using the online applicat ion radio but ton. 

5. Click on Next  > . 

6. Click on one of the displayed samples or select  Launch . 

7. The default  internet  browser is launched (an act ive connect ion is required) . 

8. Create or sign in to your Acrobat .com account . 

9. Select  Create a  New  Blank Form  or  Start  w ith a  Tem plate . 

10. Custom ize the selected form using the tools provided. 

11. All changes are stored on Form sCent ra l. 

12. Use the tools found on the Design , Test , Dist ribute , View  Responses, and 

Upgrade  tabs to build, test  and distr ibute the form . 

13. The FormsCentral toolbar contains File, Edit , I nsert , and Help  menus. 
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ACTI ON W I ZARD

Acrobat  X Pro ships with several simple predefined Act ions that  can be used to 

st ream line the workflow.  An Act ion is a collect ion of steps:   some that  Acrobat  

performs automat ically and others than it  prompts the user to complete. 

RUN AN ACTI ON 

To run an Act ion  

1. Click on the  task pane. 

2. Expand the  panel. 

3. Select  one of the items in the Act ions list . 

4. The dialog box displays a summary of the act ion. 

5. Click Don’t  show  again for this act ion  if you do not  wish to see the summary 

the next  t ime the act ion is selected. 

6. Click on Next . 

7. Depending on the nature of the act ion, a ser ies of dialog boxes may be 

presented. 

8. As prompted, select  f iles or f ile locat ions, or other informat ion needed to 

complete the act ion. 

9. A progress window displays the act ion status, task status, and inst ruct ions.  As 

steps are completed, click the status box to proceed to the next  step. 

10. When the act ion is complete, click on Close . 

 

CREATE NEW  ACTI ON 

To create a custom  act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. I n the Create New Act ion dialog box, select  the input  sources in the Start  W ith  

menu. 

5. I n the left  task pane, expand the panels, and click a task to add it .  Mult iple 

tasks may be added and they are run in the order in which they appear in the 

Steps area. 

6. Click the Opt ions but ton  to configure task opt ions. 

7. From the Save To menu, choose a dest inat ion to save the output  f ile. 

8. Check Overw rite exist ing files to allow the actdion to overwrite exist ing files 

in the dest inat ion. 

9. Click on Save . 

10. I n the Save Act ion dialog box, enter a name and descr ipt ion and click on Save . 

To display m essages in custom  act ion 

1. Create an act ion, using the steps above. 

2. After any step that  requires a message, click on Add I nst ruct ion Step  to 

insert  inst ruct ions that  will appear when the task is running.  This helps to 

communicate to users what  they need to do next . 

 

COPY ACTI ON 

To copy an act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  an act ion from the list . 

5. Click on Copy . 

6. Review the source and dest inat ion opt ions, tasks, and set t ings and modify them 

if necessary. 

7. Click on Save . 

8. I n the Save Act ion dialog box, enter a name and a descr ipt ion. 

 

EDI T ACTI ON 

Note:  Predefined act ions cannot  be edited.  I nstead, copy the act ion, as descr ibed 

above, and edit  the new copy of the default  act ion. 

To edit  an act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  an act ion from the list . 

5. To add tasks, expand the panels and click a task. 

6. Click on Save . 

7. I n the Save Act ion dialog box, enter a name and a descr ipt ion. 

 

RENAME ACTI ON 

Note:  Predefined act ions cannot  be renamed.  I nstead, copy the act ion, as 

descr ibed above, and insert  a new name for the default  act ion. 



To renam e a custom  act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  an act ion from the list . 

5. Click on Renam e . 

6. I n the Save Act ion dialog box, enter a name and a descr ipt ion. 

 

SHARE ACTI ON 

To export  an act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  an act ion from the list . 

5. Click on Export . 

6. I n the Save As dialog box, specify the name and locat ion of the file.  Act ion files 

have a .sequ extension. 

To im port  an act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  an act ion from the list . 

5. Click on I m port . 

6. I n the Open dialog box, specify the name and locat ion of the file.  Act ion files 

have a .sequ extension. 

7. Click on Open . 

8. I f an act ion by the same name already exists, an alert  appears.  Click Replace  

to overwrite the exist ing file. 

 

DELETE ACTI ON 

Note:  Predefined act ions cannot  be deleted without  adm inist rator r ights.   

To delete a custom  act ion 

1. Click on the  task pane. 

2. Expand the  panel. 

3. Choose . 

4. Select  an act ion from the list . 

5. Click on Delete . 

6. Click on Delete  to confirm . 

7. The act ion’s name is removed from the list . 

8. Click on Close . 
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